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INTRODUCTION

MTH400 is a professional radio microphone especially designed for broadcast/high quality
applications.

MTH400 is composed by 3 detachable parts:

®  MIC Head (available with cardioid/hypercardiod polar pattern).

®  MIC Body (the below part can be open to access “Display & Setup controls” area (fig.1)
and on the back the “Batteries holder & Infrared” area (fig. 2).

®  MIC Antenna, made with fibreglass reinforced housing and with a “Wireless power
switch” (fig. 3). “MIC Antenna” is fastened to body with 2 anvils and a micro-connector.

Open MIC Body:
\ Unscrew & slide down cover,
toacces internal setup controls and
0 y batteries holder & infrared.

Fig. 3 Wireless
power switch

Wireless power switch with

programmable LED
Exchange head: indication (green/red).
unscrew it counter-clockwise ‘
vl
Fig. 1 Display & Setup controls Fig. 2 Batteries holder and infrared




SAFETY INSTRUCTION

e  Read this safety instruction and the manual first

e Follow all instructions and information.

e Do not lose this manual.

e Do not use this apparatus under the rain or near the water.

e Do not install the apparatus near heaters or in hot environments, do not use outside the
operating temperature range.

e Do not open the apparatus, only qualified service technician are enabled to operate on it.
The apparatus needs servicing when it is not properly working or is damaged by liquids,
moisture or other objects are fallen in the apparatus.

e Use only accessories or replacement parts authorized or specified by the manufacturer.

e  Clean the apparatus only with dry cloths, do not use liquids.

e  Report the serial number and the purchasing date in front of the manual. It is needed to
have proper replacement parts or accessories from the manufacturer.

e  When replacement parts are needed, use only replacement parts authorized from the
manufacturer. Substitution with not authorized parts could result in electric shock,
hazards or fire.

e  Keep attention on all the labels with warnings or hazards on the apparatus.

LED INDICATION (POWER SWITCH)

Led indication with bicolor led (red & green) on wireless power switch (fig. 3):

e Wireless transmission status: green on/off

e  Battery status: green steady, slowly blinking (< 25%), quickly blinking (<12%)
e Modulation peak (if activated): red

e  PTT status: red if active

BATTERIES

MTH400 is working with 2 AA alkaline or NiMH batteries (select correct type on setup
controls). Battery status can be checked on internal OLED display or looking to LED status on
power switch (see LED INDICATION section).

Battery substitution:

e  Open MIC body: unscrew counter-clockwise the below cover to access batteries holder;
e  Take out below battery to release upper battery leverage;

e  2nd battery falls down and can be remove

Attention: always replace both the batteries



POWERING UP

Move the wireless power switch (fig. 3) in upper position (towards MIC body) to activate
wireless transmission: a green LED lights up (blinking when battery is low!).

SETUP CONTROL

Open MIC Body to access the “display and controls” area (fig. 1):

@ Graphics Display (OLED)
Channel selection buttons (ch)
MIC gain setup buttons (gain)

(54
[CJ
(D)

3 position selector (up / down / click)

Fig. 4

OLED POWER UP (OLED IS IN OFF CONDITION)

Pushing down selector (click), the graphic display oled turns on.

At the beginning a <BOOT> menu is displayed, then <STATUS> menu enters automatically. In
order to keep the <BOOT> menu active, it is necessary to push and hold selector (click) for at
least 2 sec.

<BOOT> menu
In the <BOOT> menu it is possible to found information regarding the Hardware and Firmware.

- Model (MTH400)

- Band (ex. 1)
1 470-640
2 566-798

- Hardware revision (ex. 01)

- Firmware version (ex. 110 OE)

- Band in extended format (ex. 566-798
- Serial number (ex. R3827484)




OLED POWER DOWN (OLED IS IN ON CONDITION)

Pushing and holding selector (click) > 2 sec, display is turned off.

Display turns off automatically after 15 sec, unless in <IRDA> menu or in <AUDIO> menu (with
audio level < 5% from nominal).

DISPLAY MENU

Setup menu are accessed in sequence:

- <STATUS> = <PRESET> = <TUNING> - <AUDIO> - <AUDIO> > <RF/BATTERY> 2>
< PTT/LED> > <IRDA> > <LOCK> >

Using up/down selector all menus can be accessed in sequence.

<STATUS> menu
This is the first menu displayed after power up.

Major info are displayed:
- Current channel/group (i.e. CH:00 GR:1) or

RECEIVER EF_HE | Receiver’s name (i.e. RECEIVER) if the microphone
i P00 has already been synchronized with a receiver
Rt S R N | - Current frequency (i.e. 606 MHz)

- Mic gain (i.e. -20dB) and high pass filter (i.e. Flat)
- RF active, top right label RF (if present RF is on)

<PRESET> menu
This menu can be entered by scrolling selector.

This menu allows to load a PRESET configuration,
modify the desired parameters (using the next

g 2 s menus) and save the new configuration to the USER
FID: i configuration.

SAYE: TSER When the user changes some parameters from the
= PRESET configuration (for less than frequency) a star
appears on the top-right corner until a save
command is executed.

<TUNING> menu
This menu can be entered by scrolling selector or using guick channel setup button (ch).

TLIHIHG RECEIVER In this menu current channel/group and frequencies
CH: BE GR: SYHC can be setup. Sync group is a quick self settable
: channel synchronized from receiver.




<AUDIO> menu
This menu can be entered by scrolling

selector or using quick gain setup button (gain).

The first AUDIO menu allows to set the AF Gain from
-20dB to 40dB. To help proper audio gain setting, an
audio bar is supplied (with peak hold bar) = TRY TO
SETUP TO HAVE A MAX PEAK HOLD BAR CLOSE TO -
6dB.

The second <AUDIO> menu allows to set: - audio
phase (0° or 180°)

-Noise reduction (ENR-Wisy noise optimized or ENC-
Wisy hi fidelity/voice optimized)

- High Pass filter (Flat, 60, 80, 120, 170, 250, 400 Hz)

NOTE: while in this menu display is not automatically turned off.

<RF/BATTERY> menu
This menu can be entered by scrolling

selector.

RF-BHTTEEY

Batterya: |H

RF power can be setup to High (50 mW ERP) or Low
(10 mW ERP).
Battery type can be setup in Alkaline or NiMH.

<PTT/LED> menu
This menu can be entered by scrolling

selector.

SRS | =d Light: G5
PTT Mode: Ho Data
Led Mode:|ModPealk |

Power switch green LED brightness can be setup ->
Led light (from O to 16).

4 different PTT mode can be selected: Disable,
Normal, Muting, No Data.

Led Mode setting define when the LED on the power
switch (see Fig. 3) have to become RED:

- None: never,

- ModPeak: when audio get close to saturation)

- PTT: when the PTT button is pushed

<IRDA> menu
This menu can be entered by scrolling

selector.

IRDA Enabled

By this menu, MIC can be connected to IRDA for
setup or firmware upgrades.

NOTE: while in this menu display is not automatically turned off.

<LOCK> menu
This menu can be entered by scrolling

selector.

tl_l er‘labln—: F.F & LL”_- 4

Long pressing (2 sec.) selector button (click) it locks
MTH400 in transmission mode. To unlock, long
pressing (2 sec.) selector button again.




The following table sums up which parameters can be set and the related range settings.

MENU PARAMETER | MEANING RANGE SETTINGS
TUNING CH Channel 0+59
GR Group 0+ 39 + SYNC GROUP
Freq Frequency It depends on the MTH400 Model:
1 470-640
2 566-798
AUDIO AF Gain Gain of the -20dB + 40dB step of 1 dB
audio signal
Phase Audio signal 0° or 180°
phase
Noise R. Noise reduction | ENR: Wisycom Extended-NR,noise optimized
ENC: Wisycom Extended-NC,voice optimized
HP High Pass filter Flat/60/80/120/170/250/400 Hz
RF/BATTERY RF Power RF Power High (50 mW ERP) or
Low (10 mW ERP)
Battery Battery type Alkaline or NiMH
PTT/LED Led Light Power switch 0+16
green
brightness
PTT Mode It defines how Disable:when the PTT button is pushed, nothing
and what happen. (the transmitter sends AF+Tone
information the | squelch)
transmitter has Normal: when the PTT button is pushed, the
to send transmitter send a different RF signal. According
to the receiver configuration the audio can be
enabled/disable on LINE (and/or COM).
Muting: the transmitter doesn’t send the audio.
The voice is cut, it doesn’t enter to the
microphone
No Data: the transmitter sends neither tone
squelch nor battery data.
Led Mode It defines when | None: never

the power
switch led (see
Fig. 3) has to
become RED

ModPeak: when audio get close to saturation
PTT: when the PTT button is pushed




WISYCOM IR PROGRAMMER (VER. 1.3.1.1 AND ABOVE)

Wisycom IR Programmer allows to read, modify and update the MTH400 device configuration.
It is necessary to

e install Wisycom IR Programmer (version 1.3.1.1 or above)
WARNING: If it is the first installation and Wisycom USB driver has not already
installed in the PC, install the USB driver (run C:\Program Files
(x86)\Wisycom\MTP&MTH Infrared Programmer (TX)\Drivers\ Driverinstaller.exe)

e  connected the programmer PK300 or the receiver MRK950/MRK960 to the PC thru
USB connection

e  runthe program

e  enable the IRDA communication on the transmitter (see IRDA menu)

NOTE: Wisycom IR Programmer doesn’t work whit MRK950/MRK960 if it is connected to the
PC using an ethernet cable.

The Wisycom IR Programmer’s window is divided in 4 parts (see Fig. 5):

OInterface and Device panel contains all the major information of the connected device

Current Settings panel shows the current configuration. Thanks the PRESET panel, a
previous saved configuration can be chosen and loaded like current setting.

eTuning Frequencies panel allows to handle Groups, Channels and Frequencies

Presets panel allows to read, change and save different configurations

@ Wisycom IR Programmer 2012 Rel.1.3.1.1 = =
e — —
Interface: Curent Setiings Fresets
R Preset Turing Frequencies Select
» Loc™ FEAD
| Preset  [FacTOR, | SET o[ =] Preset  [FACTORY
[ Name:  [FACTORY Il SAVE Name:  [FACTORY SAVE
@ Inteiface Connection Turig o [BE Tuning 5
o Lock:
g IR Activiy CH: Joo ~| GA: [sic x| Losk I™| Won Trequency  [Look [Hidden [~ o [ =] er [0 ] pomcas
Cormmurication Erar Freq |759.900 MHz 00 [s70.000 Freq |570.000 HHz
Audio D] 578 000 Audio = =
ool
Filer G0Hz -] Lock: T Ei :ij EEE Fiter:  |E0Hz Dont Cae: [~
Noise Fied:[ENA-Wisy - | Noise Fledt|ENFL Wiy
0+ _[602000
Device =
05_[s10.000
AFInGan =] [0 2 a 1515000 AF Gaire [12 Hae
Mic /PTT 07_[626.000 Mic /PTT
Mic Mode: Lok 1| fga Mic Hode: Lock [
% 08 _|634.000 Donit Caz: [~
Phase: 1807 - 09 |842.000 Phase:  |0°
MTH400 PTT standerd - 10_[850.000 FIT
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Status: S
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Figure 5: Wisycom IR Programmer’s window



10 different configurations are available:

e  FACTORY configuration is a locked configuration: no parameter can be changed.

e  USER configuration is the only configuration that can be saved using the OLED display (see
<PRESET> menu). Note: It is not possible to change the name of this configuration.

e  Other 8 configurations where the user can change both the name and the values of all
parameters.

INTERFACE AND DEVICE PANEL

At the beginning, the program checks which IR devices are detected and they appears on the
Interface panel.

The user has to select the device and push <connect> button in order to open the
communication with the IR device. A picture on the top in the Interface panel help the user in
this selection showing the type of devices detected. During this process the “IR activity” led
blinks to indicate that the program wait connection’s answer from the IR device.

A successful connection is signaled with the “interface connection” green led, while a failed
connection is signaled with the “communication error” led.

Once a supported device is found, the software automatically reads all the data related to the
remote configuration, as well as the frequencies that are pre-programmed.

Firstly, in order to avoid unwanted operation, no parameters can be changes and the EDIT
button, presents on the bottom of Device panel, is yellow and set to LOCKED state. Pushing
the EDIT button, it becomes grey and sets to UNLOCKED state to indicate that the
configurations can be modified.

CURRENT SETTINGS PANEL

In the Current Settings panel the user can

e with Preset panel - load one of the 10 available configurations

e  with other panels - modify all the configuration’s parameters (the same that are
changeable in the OLED display). Each parameter can be locked clicking the related
lock button, so the set value can not be changed next using the OLED display.

ATTENTION: All the modifies applied to the Current Settings panel are instantaneous: they are
applied directly to the device and save in its memory but no saved in the preset configuration.




TUNING FREQUENCIES PANEL

With the Tuning Frequencies panel the user can select a frequencies group (0+39) and for each
one execute the following operations:

- modify the Group’s Name

- lock and/or hidden the group

- for each channel (0 +59) of the selected group: change the frequency value and the
related status (locked/hidden) (in the center grid frequency)

The SAVE button, at the top of the

panel, save the changes of the group e
. ock: [

selected (name group, lock/hidden Group: | 01 v Hidden T~

Tuning Frequencies

SAVE
group). Name: IGF:EH_IF‘EH
CH  |Frequency |LUCK |Hu:|den ]n ||CH  |Frequency
00 (630,000 00 (B30.000
To change a frequency o |&30000 o |s30000
value for a specific [02_[g3n0m @ double click (@ _[sa0000
h I d bl lick 03 [630.000 03  [G30.000
channel: ouble clic
. 04 sau.uy @ Frequency 04 |630.000
on the grid frequency 05 |630.0 05 |630.000
panel (row—chan nel’s 06 B3D.DDDI Inzert frequency value [range 630-750 MHz) | 0& ?ZD.DDDI
) 07 [£30.000 Step 25.000 kHz insertfreq. value 07 [§30.000
number), insert the 08 |630.000 Frequency: 7200 MHz na - IRannnn
new frequency value oot
q Y 10 {630,000 0k cancel
and press OK button. 11 |Banonn
12 |630.000
13 |630.000 @ press OK
14 (630,000
15 630,000 ¥
ctrl-click on grid to tune channel - double click lockhidden
CH  |Frequency ]Loc:k ]Hidden ] ] To IOCk/hide a SpeCiﬁC
00 [Ban.000 channel, double click on the
M |520.000 double click to LOCK the channel idf |
- rid tr n nel.
02 |530.000 lock K‘ﬁd’d;// g equency pane

03 |&30.000 R“- double click to HIDE the channel

NOTE: keeping pressed the CTRL button on the keyboard and clicking the wanted
channel/group shown on the frequencies grid, the tuning process is executed. It is equivalent
to configure the Tuning in the Current Settings panel but it is easier. The device is re-tuned
immediately, so be sure that the RF power is turned off while changing frequencies with other
RF systems in use around you!

If the currently tuned channel is on the same group that is listed on the grid, the background
color of the related cell (channel) on the grid becomes yellow.
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Using the LOAD/SAVE button, at the bottom of the panel, it is possible to load/save the
frequencies for the selected group from/to a .wdf file. To save the frequencies of all the groups
click to the related button above. The legacy option save the channels without the hidden/lock

info.
am | [~ Load Out Freq, (lack->Hidden]
wdfFILE [ Al groups
- LOAD I [ Save legacy [ho lock/hidden)

11



PRESETS PANEL

The Preset panel allows to manage all the 10s available configurations.
For each configuration it is possible to set the name and all the parameters value except for
FACTORY and USER configurations (see table below).

PRESETS: NAME* LOCK/DON’T CARE PARAMETERS
VALUE

FACTORY

USER v

OTHERS v v v

V=change is allowed
* Be careful to write a meaningful name for the preset because the name will appear on the
settings list of the device menu! Please, avoid empty names.

If a parameter is “locked”, it cannot be modified by device menu (using OLED display), while if
“don’t care” propriety is active, when the user load the configuration, the parameter’s value
doesn’t changed.

ATTENTION: Changes are applied only after a “save” action.

NOTE: “a trick” In case of the user have a locked parameter and he is in great need for modify
it, he can save the configuration to USER configuration by OLED (see PRESET menu) and then
load the USER configuration (in this way all the parameters have the lock propriety disable and
the user can modify all the parameters).

FILE MENU
. Using a file menu at the top left of
File L::Ideser Couation ' the panel it is possible to load/save
Save User Configuration all the configuration values of the
- ' device to/from a .wcf file (Wisycom

Configuration File).

Save a .wcf file
With an infrared device correctly connected, select File->Save User Configuration and select
the destination file.

Load a .wcf file

To load a user configuration select File->Load User Configuration and select a previously saved
data file; a form will be shown, where it's possible to select which data has to be restored and
which skipped. This allow the user to load a particular configuration while keeping other data.



TECHNICAL SPECIFICATIONS

Switchable channels

Switching window
Frequencies
Frequency stability

Temperature range
Max RF power
Spurious emissions
Modulation
Nominal deviation

Telemetry feature

AF input connection
AF input level
Max. input level

Max sound pressure

Noise-Reduction

AF bandwidth
Distortion

Signal-to-noise ratio

Led

Display

Power supply
Battery life (alkaline)

Dimensions

Weight

Note: The above technical specifications refer to the MTH 400 “transmitter” section. The acoustic specs are relevant to

2400 allocated by 40 groups of 60 channels (in specific frequency range),
quickly selectable with dedicated buttons

Up to 232 MHz, depending on band (see below code table)

Quartz PLL frequency synthesizer circuit (25 kHz step)

* +2,5 ppm (in the rated temperature range)
= +2.5kHz (in the rated temperature range)

-10++55°C

= 50 mW (ERP) when high power selected (note: In some countries high
power can be disabled, for local norm!)

= 10 mW (ERP) when low power selected (to respect some local norm)

<2nW

wideband FM, with 10 us pre-emphasis

+40 kHz (Peak deviation = 56 kHz)

MTH400 transmits also a digitally modulated sub-carrier, suitable for:
= tone-squelch = remote battery = optional PTT (push
operating monitoring to talk) operation

Directly interchangeable microphone-heads

-60 + +0 dBu nominal, quickly settable by steps of 1 dB with dedicated
buttons

+6 dBu

150 dB SPL (0,5% THD), with
MCM301/MCM302/MCM303/MCM304/MCM305 condenser-heads

ENR (Wisycom Extended-NR), with independent Attack- and Recovery-time,
noise optimized

ENC (Wisycom Extended-NC), with independent Attack- and Recovery-time,
voice optimized & with reduced pre-emphasys

45 Hz + 21 KHz (3dB)
55 Hz + 20 KHz (1dB)

<0.3% (0.15 % typ.)

typ. 115 dB (A),ms with 40kHz deviation
typ. 121 dB (A),ms with 56kHz deviation

Led indication with bicolor led (red & green) on wireless power switch:
= Wireless transmission status: GREEN on/off
= Modulation peek (if activated): RED
= Battery lifetime status: GREEN
- steady (> 25%) - slowly blinking (< 25%) - quickly blinking (<12%)
= Ptt status: RED if active

High contrast OLED (Organic light-emitting diode) display (96 x 36 pixels)
8 step battery lifetime indication: 7 bars (100%-87%-75%-63-50%-38%-25%)
and “empty bar” quickly blinking (12% remaining)

2 AA size cell (Alkaline, rechargeable NiMH)

approx. 11 hours @ 50mW continuous working; up to 14 hours @ 10mW

= body max. diameter 33 mm (without microphone-head)
= total length 183 mm (without microphone-head)

Approx. 300g, including battery and MCM3xx (condenser) mic-head ( approx.
260g batteries excluded)

the microphone-head used. The MTH 400 transmitter complies with ETS 300 422.



OPTION CODE MTH400-YZ-O:

« COLOR (Y)

] body color "matt black"
& body color titanium gray,

(ceramic coating)

« OTHER OPTIONS (-0)

= FREQUENCY RANGE (-2)
Il 470-640 MHz
Al 566-798 MHz

EXAMPLE: MTH400 B2 is color matt black, and 566-798 MHz frequency range
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Obblighi di informazione agli utilizzatori

Modello di informazioni agli utenti dei prodotti di tipo “professionale”

INFORMAZIONE AGLI UTENTI

ai sensi dell’art. 13 del Decreto Legislativo 25 luglio 2005, n. 151 “Attuazione delle Direttive 2002/95/CE,
2002/96/CE e 2003/108/CE, relative alla riduzione dell’uso di sostanze pericolose nelle apparecchiature
elettriche ed elettroniche, nonché allo smaltimento dei rifiuti”

giunta a fine vita.

Il simbolo del cassonetto barrato riportato sull’apparecchiatura o sulla sua
confezione indica che il prodotto alla fine della propria vita utile deve essere
raccolto separatamente dagli altri rifiuti.

La raccolta differenziata della presente apparecchiatura giunta a fine vita e’
organizzata e gestita dal produttore. L'utente che vorra disfarsi della presente
apparecchiatura dovra quindi contattare il produttore e seguire il sistema che
questo ha adottato per consentire la raccolta separata dell’apparecchiatura

L’adeguata raccolta differenziata per I'avvio successivo dell’apparecchiatura dismessa al riciclaggio,

al trattamento e allo smaltimento ambientalmente compatibile contribuisce ad evitare possibili effetti

negativi sull’ambiente e sulla salute e favorisce il reimpiego e/o riciclo dei materiali di cui € composta

"'apparecchiatura.

Lo smaltimento abusivo del prodotto da parte del detentore comporta I'applicazione delle sanzioni am-

ministrative previste dalla normativa vigente.
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DECLARATION OF CONFORMITY

DICHIARAZIONE DI CONFORMITA'
DECLARATION OF CONFORMITY

Il sottoscritto. rappresentante il seguente costruttore
The undersigned, representative of the following manufacturer

WISYCOM S.r.l.
via Spin, 156 - 36060 Romano d’Ezzelino (VI) - Italy

DICHIARA che I’apparecchiatura descritta in appresso:

DECLARES that the product:

Descrizione Handheld trasmitter

Description

Modello Mth400

Model

¢ conforme alle disposizioni legislative che traspong le seguenti direttive:

e direttiva 2004/108 CE (Direttiva EMC)
o direttiva 2006/95 CE (Direttiva Bassa Tensione)
e direttiva 99/5 CEE (Direttiva Apparecchiature Radio)

is in accordance with the following Directives:

o 2004/108 EC Directive (EMC Directive)

e 2006/95 EC Directive (Low Voltage Directive)
e 99/5 EEC (Radio Equipment Directive)

e che sono state applicate tutte le norme e/o specifiche tecniche di seguito indicate
and that all the following standards have been applied

EN 60065:2002 + A1:2006 + A11:2008 + A2:2010 + A12:2011
EN 301 489-1 V1.9.2

EN 301 489-9 V1.4.1

EN 300 422-2 V1.3.1

Luogo Romano D’Ezzelino
Place

Data 25 July 2012

Date

Firma Franco Maestrelli

Sign WISYCOM s.r.l.

(nome e funzione) ranco Maestrelli
(name and title) Loy

mth400-ce declaration doc
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A Wisvycon

WISYCOM srl

Via Spin 156 e 1-36060 Romano d’Ezzelino e ltaly
Tel. +39 -0424 -382605 o Fax +39 - 0424 - 382733
Www.wisycom.com e e-mail: sales@wisycom.com
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